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RecoRd of Updates 

Update VeRsion pUblication date 

1.0 August 2011 

inqUiRies 

Inquiries and correspondence about the Cancer Risk Management 
Model can be directed to: 

canadian paRtneRship against canceR 

1 University Avenue, Suite 300 
Toronto, ON M5J 2P1 

Telephone: 416-915-9222 
Toll free: 1-877-360-1665 
Fax: 416-915-9224 

Email: riskmgmt@cancerview.ca 
Website: partnershipagainstcancer.ca 

cancerview.ca/cancerriskmanagement 

AbOUT ThE CANADIAN PARTNERShIP AGAINST CANCER 

The Cancer Risk Management Model is an initiative of the Canadian Partnership 
Against Cancer, an organization funded by the federal government to accelerate 
action on cancer control for all Canadians. bringing together cancer experts, 
government representatives, the Canadian Cancer Society and cancer patients, 
survivors and their families through the Canadian Cancer Action Network to 
implement the first pan-Canadian cancer control strategy, the Partnership’s vision 
is to be a driving force to achieve a focused approach that will help prevent cancer, 
enhance the quality of life of those affected by cancer, lessen the likelihood of 
dying from cancer, and increase the efficiency of cancer control in Canada. 

For more information, visit partnershipagainstcancer.ca 
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aboUt this UseR gUide 

The questions below will help you understand the objectives of this 
User Guide. 

1.	 What can I do with the Cancer Risk Management Model platform? 

The Guide will provide you with a framework of the Cancer Risk Management 
Model (CRMM) platform — how the different parts of the model fit together, 
which parts can be changed, and which parts cannot be changed. Understanding 
the framework will make it possible to plan your research questions within the 
power and capabilities of the system. 

2.	 How do I use the system to answer my research questions? 

This Guide provides a set of hands-on tutorials that will introduce you to all 
of the important features in the CRMM platform. The tutorials start with a 
more general approach, and become more detailed as they progress through 
comparing scenarios and creating new scenarios. The final tutorial walks you 
through building up aggregate costing in an integrated Excel workbook for a 
new drug intervention scenario. We recommend working your way through 
all of the tutorials. 

3.	 Where can I get more details on how to use a particular part of 
the CRMM platform? 

Several Details sections in this Guide complement the help system built-in to 
the platform. The Details sections are intended to clarify special issues that 
may arise as you conduct your research. The help menu provides access to 
a set of video tutorials and step-by-step instructions for common tasks. These 
instructions are not duplicated in this User Guide. 

figure 1: The Help menu for Common Tasks in the Cancer Risk Management Model Platform 
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AbOUT ThIS USER GUIDE 

figure 2: The Help menu for Tutorials in the Cancer Risk Management Model platform 

4.	 Does this Guide contain the references and data sources for the 
Model inputs and rules? 

No, these are built-in to the Cancer Risk Management Model platform in the 
form of Information notes, Model Release Notes and the Cancer Management 
workbooks. The Guide does contain a section on how to find what you need 
among all the sources of documentation - see Understanding Data Sources 
and References. 

5.	 Does this Guide help me learn about microsimulation 
programming of the Cancer Risk Management Model? 

Cancer Risk Management Model is computed using a computer language 
called “Modgen” developed by Statistics Canada. This Guide is not intended 
to address Modgen programming or altering the structure of the underlying 
models. Instead, the focus is on using the models published within the web-
based Cancer Risk Management Model platform. You can use the link below 
to learn more about Modgen if you decide to explore programming further: 
http://www.statcan.gc.ca/microsimulation/modgen/modgen-eng.htm 
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administRation: 

accoUnts and RegistRation 

ReqUest foR an accoUnt 

Information about the Cancer Risk Management Model can be 
found at: www.cancerview.ca/cancerriskmanagement Follow the steps 
below to request a user account: 

step 1: 

Complete and submit a User Account Request Form. The information on the 
form will be reviewed and verified by the Canadian Partnership Against Cancer 
(the Partnership). 

step 2: 

Within two business days of submitting your form, you will receive an e-mail 
from the Partnership with instructions on the final steps to complete your 
account request. 

step 3: 

Complete the final steps outlined in the e-mail. You will create a username and 
password, allowing you to login the Cancer Risk Management Model platform. 

‘cRmm UseR space’ on canceR View canada 

CRMM User Space, powered by Cancer View Canada, is a collaborative space 
for model users to share documents, post comments and ask questions 
related to the use of the model. Useful resources such as model workbooks, 
User Guide and list of Q&A’s will be added to the space by the CRMM 
development team. Once the access is granted, users can log in the CRMM 
User Space via: www.cancerview.ca/login “Model Login”. 

Log in to the Cancer Risk Management Model platform via: cancerview.ca/ 
cancerriskmanagement, Model Login; or via the CRMM User Space. 

Recommended bRowseR 
The recommended browsers for use are Microsoft Internet Explorer (IE) version 81 or 
9, and Mozilla Firefox. We caution that while most of the Cancer Risk Management 
Model (CRMM) platform will appear to function on Google Chrome, there may be 
particular issues with creating a new scenario on the platform using these browsers. 

1 Users who use the platform on IE8 browser may be unable to download the Excel workbooks from the platform. 
When encountering this issue, users can obtain the workbooks via the ‘collaborative space’ as part of their 
access to the Cancer Risk Management Model. 
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Must-knoW ConCepts & teRMs 

CanCeR RIsk ManaGeMent MoDel 
Cancer Risk Management Model is a population-based, dynamic microsimulation 
model. Microsimulation is a mathematical modeling technique in which individual 
cases are simulated, one at a time, from birth to death. The information from all 
the simulated lives is then combined to produce aggregate measures of health 
outcomes for the population, or for particular subpopulations (e.g. by province, age 
or sex). The primary value to researchers and policy makers is those projections can 
measure the effects of proposed interventions before they are implemented in a 
population. In the Cancer Risk Management Model (CRMM), each simulated case 
represents a life. The life cases are based on known and projected demographic 
data and have a set of decision points governing how each case will proceed. 

In CRMM, you can simulate a representative (albeit synthetic) sample of the 
population in a ‘what-if’ scenario by running a set number of life cases. For example, 
a scenario could be run in which an intervention reduces the smoking rate by 10%. 
As this scenario is run, all of the simulated lives play out according to the model’s 
algorithms and inputs. At the teen smoking decision point of each life, the smoking 
rate input parameter is referenced by the algorithms, and the courses of some lives 
are changed (some smoke, some do not). The output data from all of the simulated 
lives can then be compared with the projections resulting from the existing smoking 
rate to examine the potential effects of the intervention. 

INPUT 
PARAMETERS 

variable data 

CRMM 
microsimulation 

algorithm 

SCENARIO CREATION 

OUTPUT 
TABLES 

data projections 

soMe IMpoRtant teRMs In tHe CanCeR RIsk 

management model: 

A Scenario is a set of instructions (in the form of 
input parameter settings) that run a specified 
number of synthetic lives and collect the resulting 
output into tables. 

The base case scenario for each model is a run of 
the synthetic lives with the model’s default set of 
input parameters. 

output tables are views of the data projections 
produced by running a scenario. Each output table 
provides a view of a particular set of outcome measures. 
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MUST-KNOW CONCEPTS & TERMS 

UPTO 2007 DATA† 
Canadian Cancer 

Registry 

STATUS QUO 

BASE CASE SCENARIO 

† Staging was based on 2004 - 2007 data; 
incidence was based on 2004 - 2006 data. 
For model assessment, the Model compared 
projected incidence to Canadian Cancer 
Statistics numbers (which are based on 
Canadian Cancer Registry) out to 2009 

“WHat-If” sCenaRIos 

The base case acts as the starting point for all other scenarios 
in two ways: 

1.	 The base case reflects a status-quo scenario, where the projection 
is based on current and historical observed data with plausible 
assumptions. The current CRMM base case scenario represents a ‘status 
quo’ projection based on registry data as of 2005 and clinical practices 
reflecting the time period of 2007-2009 and thus provides a reference 
against which to test possible interventions. 

2.		 All other scenarios within the platform are variations on the base case. 
To create a new scenario, you may update the base case, or any existing 
scenario, by changing one or more input parameter values then running 
the new scenario to generate projections. 

Structural changes to the model and tables (for example, adding a new input 

parameter or a new output table) require access to the source code, which cannot be 

done within the Cancer Risk Management Model platform. Modifying source code is 

beyond the purpose of this Guide. 

Users can update the simulation by creating new scenarios to examine the impacts 
of a particular intervention of interest. Examples of interventions include screening 
programs, drug treatment plans, preventative measures and rates of risky activities 
like smoking. Those assumptions were implemented by changing the input parameters. 
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MUST-KNOW CONCEPTS & TERMS 

The diagram below shows a ‘family tree’ view of how some of the Colorectal Cancer 
screening scenarios were created, first from the base case, and then from each 
other to create sets with a range of input parameter values. 

Below: Examples of scenario creation beginning with the base case scenario. This diagram 

shows various ways to reach six different outputs. 

BASE CASE SCENARIO 

Screening Rate: 30% 
Phase-in: 2-year 

OUTPUT 1 OUTPUT 4 

Phase-in: 6-year Phase-in: 4-year 

Start year: 2015 

Phase-in: 4-year 

OUTPUT 2 OUTPUT 3 OUTPUT 5 

OUTPUT 6 

Screening Rate: 50% 
Phase-in: 2-year 
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MUST-KNOW CONCEPTS & TERMS 

CanCeR ManaGeMent WoRkbooks
	

Above: Diagram of Scenario creation using Workbooks 
to determine some Input Parameters 

OUTPUT 

WORKBOOK 
calculations of costs, 
probabilities, durations 
and health utilities 

INPUT 
PARAMETERS 
workbook values are 
input manually 

WORKBOOK & INPUT PARAMETER INTEGRATION Within the CRMM, there are separate models that govern 
each cancer (e.g. lung, colon, and rectal). These are built in a 
form of algorithmic code that is not visible to the end-user – 
like the inside of a machine. To help end-users gain a better 
understanding of the cancer pathways embedded in the 
model, Excel workbooks for each cancer are provided in every 
model release. 

These Excel workbooks provide transparency of methodology, 
data sources, and documentation of the treatment algorithms, 
costs and related data. You can use the workbook to re-calculate 
and examine aggregated healthcare direct costs which are 
high-level input parameters (i.e.treatment costs for chemotherapy) 
in the CRMM platform. 

For example, the chemotherapy treatment cost value seen in the 

CRMM Base case input parameter is calculated in the workbook 

from aggregates that include the cost of the drug itself, proportion 

of patients treated, number of chemo nursing hours, and number 

of visits and so on. 

cancerview.ca/cancerriskmanagement CRMM USER GUIDE - PAGE 11 



  

  

      
  

 
 

 

 
   

 

 

 

gUided toUR: 

an oveRvIeW of tHe CanCeR RIsk 
management model 

In this section, you’ll learn about the layout of the CRMM in terms 
of the concepts introduced in the previous section — Models, 
Scenarios, Input parameters and Output Tables and the Cancer 
Management workbooks. 

the all scenaRios page 
This important page is displayed immediately after you sign in to the Cancer Risk 
Management Model. It displays all of the models and their associated scenarios, 
in sets of folders. 

Version of Model 

Model Release Notes, 
Model Workbooks, 
Data Dictionary 

base case scenario 
for Model 1.2 

Run size 

figure 3: The All Scenarios Page 
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AN OVERVIEW OF ThE CANCER RISK MANAGEMENT MODEL 

When you sign in, you will see the following folders: 

· Model Documentation folder  contains downloadable versions of the 
Model Release Notes, Cancer Management workbooks and the Data 
Dictionary of the input parameters information. 

·	 Working sets folder will be empty but later will contain any scenarios 
you create that are either ready to run or are currently running. 

· My scenarios folder  will be empty but later will contain any scenarios 
that you create and have run. You can create new folders within this 
folder to organize your new scenarios. 

· public scenarios folder  contains pre-run scenarios that demonstrate 
particular aspects of the model. 

Notice the help menu in the menu bar. It provides detailed help on the CRMM 
features as well as a set of short video tutorials about common tasks. before you 
proceed with this guided tour, it is recommended that you view the Using scenarios 
and folders tutorial. 

figure 4: The tutorials in the Cancer Risk Management Model platform 
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AN OVERVIEW OF ThE CANCER RISK MANAGEMENT MODEL 

the scenaRio View 
Once you click to select a scenario, the list of Output Tables for the scenario is 
displayed in the left panel. In the diagram below, the currently selected table 
Cancer Cases by provinces, sex and year (highlighted in gold in the left panel) 
is displayed in the right panel. 

View of currently 
selected Output Tables 

Scenario title 

Output Table title 

List of output tables 
produced by running 
this scenario 

figure 5: Output tables view 

Clicking the Input Parameters tab displays the list of input parameters that were 
used to run and produce the output tables for this scenario. 

View of currently 
selected Input Parameters 

Create new Scenario 

List of input parametres 
(currently selected 
parameter is 

highlighted in gold) 

Export to Excel 

figure 6: Input parameters view 
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AN OVERVIEW OF ThE CANCER RISK MANAGEMENT MODEL 

the infoRmation page 
Clicking on the information button  beside the title of a model, scenario, input 
parameter or output table will display an information page for that item. It contains 
notes, data sources and/or definitions for the selected item. 

figure 7: Information button for each parameter 

help menU 
The help Menu on the CRMM platform provides directions for common tasks, and 
a set of video tutorials which show step-by-step examples of performing specific 
operations. For help with specific tasks, click help then select from the index, links 
or search for a particular term. 
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AN OVERVIEW OF ThE CANCER RISK MANAGEMENT MODEL 

CanCeR ManaGeMent WoRkbooks 
Workbooks that match the particular version of the model are provided in the 
Model Documentation folder within a Model folder in the All Scenarios View. 
Clicking a workbook will launch the download process. 

figure 8: Model documentation 
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AN OVERVIEW OF ThE CANCER RISK MANAGEMENT MODEL 

Each sheet in the workbook provides details to understand the inter-relationships 
between parameters and computations to change and understand the underlying 
costs, durations etc. that are used to calculate the input parameter values for the 
particular version of the model. To learn how to copy and paste from a Cancer 
Management workbook to a particular parameter, see Section: Copying and Pasting 
from Excel, and the Example: Copy Lung Cancer Treatment Probabilities from Workbook. 

figure 9: Cancer management pathways in the workbook 

breakdown of all underlying costs 
to compute total cost 

These values are used 
in probability sheets 
and parameters 
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finding, Using and 
UndeRstanding oUtcome 
pRojections 

Within the CRMM platform, each model version includes a folder of 
public scenarios which contain pre-run scenarios for all CRMM users. 
The tutorial below will guide you through an exploration of the inputs 
and outputs of scenarios. 

tUtoRial: fInD anD CHeCk tHe outCoMe pRojeCtIons 

foR the base case scenaRio 

·	 Make sure you’ve read through the Must-Know section so that you 

understand the basic concepts and terminology. 


·	 Look through the Guided Tour section to get an idea of how the CRMM 
platform is laid out. 

The CRMM platform starts at the All Scenarios page. Under each 
available model, you’ll see a set of scenarios organized into folders. 
Folders can be expanded to see all of the scenarios inside or collapsed 
by clicking the +/- button beside them. If there is no button, the folder 
is currently empty. 

The first thing you’ll want to view in the model is the base case scenario. 
Understanding the projections and inputs to the base case scenario is essential 
because it provides the starting point for all other scenarios. 

sign in so that you can view the All Scenarios page. 

find the Cancer Risk Management Model 1.2 folder on the page – we’ll work 
from this model. 

select (single click) the base case scenario (default) in Cancer Risk 
Management Model 1.2. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

Clicking a scenario opens up the Output table list for the scenario, with a tab to 
open the Input parameters. In the left panel, you can see a list of output tables and 
groups of output tables. The first output table is selected. 

The selected table Cancer cases by province, sex and year, is highlighted in gold in 
the Output table list. Notice the buttons that act on this table are over on the right, 
above the values. All of the button actions are also available, along with additional 
features, in the menus (File, View, Dimensions) above the Output Tables tab. The table 
values are displayed in the table’s default view on the right, in this case Chart view. 

click the data link (it’s above the chart), or select View as data from the View 
menu. The view will now show the Cancer cases by province, sex and year 
output table as numerical values in columns and rows. 

The data is arranged into dimensions in rows, columns or as filters. A dimension is a 
category of data, like Province or Year. Clicking the dimension name provides a list of 
the members of the dimension to display. 

click the word measure – the dimension title for the rows in the table. 

You can see that not all of the possible members of Measure are selected. 

Click in the selection box beside Lung cancer deaths to display these values 

in the table view.
	

Click the show view button to apply these selections to the data view. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

The Lung cancer deaths member is now displayed in the table data view. This is 
a temporary view — you would need to save it (from the File menu) if you wanted 
to view it again later otherwise it will revert to the default view. Notice that this 
view of output table was set up to have the Province and Sex dimensions displayed 
as filter above the chart or data. For both filters, ‘All’ is selected. This tells us the 
values displayed are aggregated for all members of Province and Sex. Selecting 
a filter member will show only the values for that member. 

click the blue triangle  in the Province of Residence block to filter this view 
of the output table for Cancer cases by province, sex and year. Choose your 
province from the filter menu. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

Now look back to the left panel to the list of Output tables. Each output table presents 
a set of outcome measures in a particular default view. If you are looking for a particular 
outcome measure, you would first look at the titles of these output tables to see if it 
is already captured in an output table. To find a likely-looking output table, you can 
expand and collapse groups of tables individually by clicking the plus/minus icon, 
or overall, by using the Expand or Collapse All buttons at the top. 

expand all the Output Table groups in the left panel with the expand all 

button 


find the Colorectal cancer tables group. 

find and select the output table: Colorectal cancer screening outcomes by 

province, sex and year.
 

. 

Hint: If the title is cut-off by the panel, hover your cursor over the title to see 
the entire title. A small yellow box will appear (as shown above) displaying 
the entire title 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

Notice the Measure in the 2nd row of the table above is Number screened (number 
of tests) – it’s easy to spot because the row shows zero (0) across all of the years. 
In this particular example of colorectal cancer screening, it refers to the era before 
any organized screening program was implemented in Canada. 

At this point, you may want to go see the input values that were used to create this 
scenario to get a better understand of the connection between the input parameters 
and the output tables. There are two tabs below the main menu — one for viewing 
Output tables and one for the Input parameters. 

click the input parameters tab above the list of tables to view the input 
parameter values that were used to create this base case scenario. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

Just like the Output tables, you can see a list of Input parameters on the left, and 
the values for the parameter selected on the right. Notice that though we were 
previously looking at colon cancer outputs, the first parameter visible is for smoking. 
CRMM simulates lung and colon cancer in a single integrated population-based 
framework, so all parameters and output tables for all modeled cancers are present. 

click the plus sign beside Colorectal Cancer to expand the group. Then 
expand the Screening group. 

select the parameter titled Participation rates to organized screening for 
colorectal cancer. 

Notice the connection between this input parameter setting of 0 for the participation 
rates to ‘organized screening’ and the associated output projections we saw a few 
minutes ago, of zero people screened. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

Collect your thoughts: Up to this point, you have selected the Base 
case scenario, viewed some of the projections as outcome measures in 
output tables and examined an input parameter to better understand 
the output projections. 

click all scenarios (top right above the language selector) or use the View 
menu to select All Scenarios 

find the screening scenario titled FIT 50%, 2 year phase-in 2010-11, biennial. 

Click the Information button  at the end of the scenario title. 

The scenario information shown above was entered when the scenario was created. 
The information describes the input parameter changes and captures the purpose 
of the scenario. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

After reviewing the scenario information, return to All Scenarios to select and 
view the scenario. 

Return to the All Scenarios page. find the Cancer Risk Management Model 
1.2 and the Public Scenarios folder below. 

select the scenario FIT 50%, 2 year phase-in 2011-12, biennial. 

click the input parameters tab. 

expand Colorectal Cancer and Screening. 

select the parameter titled Participation rates to organized screening for 
colorectal cancer. 

Participation rate for 
FIT set to 50% 

Participation rates 
parameter selected 

Find the column for the participation rate for Fecal Immunochemical Testing (FIT). 

In contrast to the participation rate of zero in the base case scenario for all colorectal 

screening techniques, the FIT participation rate parameter is set to 0.5 (or 50%), 

in this scenario. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

At this point, you have confirmed that this is the scenario with the 
screening parameters you need. Now you’ll want to look at the output 
data projections. 

click the output tables tab to see the output tables for this scenario. 

expand Colorectal cancer tables 

select Colorectal cancer screening outcomes by provinceand year 

Notice that the Number screened measure now shows millions of screening tests 
in each year, in contrast to the same output table in the base case scenario, which 
showed no screening tests. 

Let’s assume that this table is what you need. A likely next step would be to export it 
to an Excel file you can use on your desktop. 

Click export data from the File menu. 

Use the default file type of XML for Excel and click ok. 

Warning: If you are using Internet Explorer 8, you will have to start the 
download again after approving it in the yellow security bar at the top of 
the window. E.g. Click Export, then Ok, click Download file in security bar, 
then go click Export and OK again. 

save the file with a meaningful name — the system will give it the name 
‘Download.xlm’. 

At this point, you may wish to have a look at the file and open it in Excel. 
Go ahead, and then come on back. 
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FINDING, USING AND UNDERSTANDING OUTCOME PROJECTIONS 

INPUT 
PARAMETERS 

variable data 

CRMM 
microsimulation 

algorithm 

SCENARIO CREATION 

OUTPUT 
TABLES 

data projections 

Collect your thoughts: 

You have viewed the Base case and a · 
what-if scenario for a screening program. 

Viewed some of the projections as outcome · 
measures in output tables. 

Examined input parameters to better · 
understand the output projections. 

Selected an output table with the measures · 
you needed and exported it to your desktop. 

next steps 

Instead of examining each parameter to look at the differences 
between the FIT screening and the base case, you could compare 
scenarios to see all of the differences, across both inputs and outputs. 
Learn more about comparing scenarios in the next section. 

The output tables may not be formatted to suit you (for example, you want to 
highlight some values with color or switch columns with rows). Learn more about 
formatting output tables in the details section. Once your output tables look right, 
or to keep a comparison view with the original table, you’ll need to save the view. 
To learn more, watch the video tutorial ‘Saving table and parameter views’ available 
in the help menu. 
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analyzing and compaRing 
acRoss scenaRios 

In this section, we will examine how to compare scenarios within 
a model or across models. There are a number of reasons why you 
might wish to compare scenarios. We’ll start with some examples of 
how and why you can conduct different types of comparisons. 

examples of sCenaRIo CoMpaRIson tasks 

1.	 compare a single output table across 3 to 5 scenarios to see  
the changes in a set of measures. 

example: In the Colorectal cancer scenarios, there are 5 different guaiac fecal 
occult blood test (gFObT) screening scenarios. You might wish to look at the 
differences in a particular set of measures in an output table across all 5 of 
these scenarios. You’ll try this yourself in the tutorial below. 

2.	 Compare two scenarios within a model to see differences 
resulting from two sets of parameter inputs. 

example: You may have created an intervention scenario. You can compare 
your new scenario to another scenario. The results will show the set of outputs 
and inputs with differing values between the two scenarios. This provides 
a complete picture of the changes between the two scenarios. 

3.	 Compare identical scenarios across models to see all of the 
differences resulting from two model versions. 

example: You’ve been working on a research question and have created new 
scenarios to explore the projections. At this point, a new version of the model 
is released. You read through the release notes, and decide to use the new 
model. To fully understand the changes, you compare a scenario in the new 
model version to the identical scenario in the previous model version. 
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ANALYZING AND COMPARING ACROSS SCENARIOS 

tUtoRial: compaRing an oUtpUt table acRoss 

mUltiple scenaRios 

There are 3 public scenarios in Cancer Risk Management Model 1.2 
modeling different implementations of FIT screening programs. In this 
tutorial, we will compare the number of colonoscopies performed 
across these different screening program scenarios. 

select the scenario titled FIT 30%, 2 year phase-in 2011-12, biennial 

expand the Colorectal cancer tables group 

select the output table titled Colorectal cancer screening outcomes  
by province and year 

Notice the Total number of colonoscopies measure in the data view on the right. 
We’ll compare this table in the currently-selected FIT 30% scenario across the FIT 
50% and 80% participation rate scenarios which also phase in over 2 years and 
start in 2011. Comparing this particular set of scenarios allows us to isolate the 
participation rate as the measure of interest. 
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ANALYZING AND COMPARING ACROSS SCENARIOS 

click the scenario link located directly above the data table or select 

compare scenarios from the Dimensions menu. 


In the Compare scenarios box that appears, all of the scenarios containing 

comparable output tables are visible. 


check the fit 50% and fit 80% scenarios to include them in the comparison.
	

click show view.
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ANALYZING AND COMPARING ACROSS SCENARIOS 

We can now see the values of all three scenarios to examine the impact of the 
participation rates on the deaths and cost estimations. Notice that it was also 
possible display the comparison data as Differences and Ratios. As expected, the 
projected number of colonoscopies performed each year increases for the scenarios 
with the higher participation rates. 

At this point, we’ll check that enough cases were run that the reliability of the 
simulation estimates, as measured by the coefficient of variation, is within the 
target range of below 5%. Learn more about reliability in CRMM. 

select the Coefficient of variation (%) from the Output menu. 

cancerview.ca/cancerriskmanagement CRMM USER GUIDE - PAGE 31 



  

 

 

   
 

 

 

ANALYZING AND COMPARING ACROSS SCENARIOS 

before switching to the view of another table, we’ll save this Comparison view so 
it’s always available in this scenario. Make sure to switch back to the Values for the 
Output first – right now we’re still viewing the coefficient of variation. 

select Values from the output menu. 

select save view as… from the file menu. 

enter the title ‘Comparison across FIT 
scenarios’. 

Since the saved view is derived from a specific output table, the saved view is shown 
under the original table in the list of Output tables in the panel on the left. 

next steps 

Learn more about comparing scenarios: click help / tutorials / 
comparing scenarios to watch the brief video tutorial in the 
help menu. 

Our next step would be to export (use the Export data command in the File menu 
or the Export button ) this comparison view to Excel for further analysis of the 
outcomes across the different participation rates. 
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ANALYZING AND COMPARING ACROSS SCENARIOS 

tUtoRial: compaRing two scenaRios acRoss model 

VeRsions oR within a model 

In this tutorial, we’ll compare identical scenarios across versions of a 
model. This will also introduce you to the process for comparing two 
complete scenarios within a model, since it uses the same method. 

For the purposes of the tutorial, we’ll look at the changes to the base case scenario 
between release version 1.2 and release version 1.0 of the Cancer Risk Management 
Model. Notice the identical run sizes of the base case scenarios in both versions of the 
model (both were run with 32 million cases in this example). It’s important to ensure 
that run sizes are the same before you run a comparison of outcome projections like 
the one below. If the run sizes were different, differences in the outcome projections 
of the scenarios could be attributed to different run sizes (i.e. Monte Carlo errors), 
in addition to the effect from input parameter differences. 

Start on the All Scenarios page. 

select compare scenarios from the 
View menu. 

Set the Model to Cancer Risk Management Model 1.2. 

select the base case scenario as the Scenario. 

set the Reference model to Cancer Risk Management Model 1.0. 

Click ok. Wait while the system works through the scenarios to find 
the differences. 
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ANALYZING AND COMPARING ACROSS SCENARIOS 

The Compare entire scenarios page shows four groups of comparisons across input 
parameters and output tables. 

ValUes changed 
· parameters : the input parameters were set to different values in these scenarios 
· tables : the output tables contain different projections across the two scenarios. 

new 
·	 Shows input parameters or output tables that were added to the new model 
CRMM 1.2. (e.g. did not exist in the 1.0 release version of the CRMM). 

deleted 
·	 Shows parameters or tables that were present in CRMM 1.2 that no longer 

appear in CRMM 1.0.
	

stRUctURe changed 
·	 Shows parameters or tables that have different dimensions or the dimensions 
are moved, filtered or displayed differently. 

Let’s start examining the changes by looking at the new parameters that were 
added in CRMM 1.2. 

click the plus sign beside the New group to expand, and expand the 
Parameters group. 
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ANALYZING AND COMPARING ACROSS SCENARIOS 

expand the Values Changed group, 

select Lung cancer treatment duration from the Parameters list. 

View title shows it is a 
comparison view 

Value has changed 
to 10 years 

In this comparison view of the two scenarios, the parameter values for the two 
scenarios show that the Cured value has been changed to from 0 to 10 in the CRMM 
1.2 base case scenario. Note that the information for the comparison view is for the 
1.0 reference scenario, rather than for version 1.2. According the Information note 
for this parameter in Model release version 1.2, the cured duration was previously 
hard-coded to 5 years and this Cured dimension of 0 was not used. In Model 1.2, 
the Cured dimension was implemented, and set to 10 years. The new value was 
chosen based on a re-analysis of survival data from the literature. 

Something important to understand: the information notes and the other parameters 

in the left panel are for the Base case scenario of the reference model in the comparison. 

They do not show all the comparisons. You will only see the comparison view if you 

select the parameter or table from the Compare Entire Scenarios page. However, to 

ensure that this comparison remains within the Base Case scenario for Model 1.0, you 

could save the view by selecting Save view as… from the File menu. 

select the Compare entire scenarios link from the View menu to return to 

the Compare page
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ANALYZING AND COMPARING ACROSS SCENARIOS 

Collect your thoughts: You have... 

·	 Compared the Base case scenarios from different versions of 
similar models to better understand the updated model and its 
implications on your work. 

·	 Expanded the New group to see the parameters that were 
added to the latest version of the model. 

·	 Examined an input parameter from the Values changed group 
to show a comparison view of the values that are used in the 
two versions of the model. 

· Returned to the Compare entire scenarios page to continue 
your exploration of the differences that the two models on the 
Base case scenario. 
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geneRating new pRojections 
by cReating scenaRios 

The base case scenario sets out the input parameter defaults for 
a particular model version. To create a new scenario, you will follow 
this process: 

1.	 Identify and select an existing scenario (often the base case) which the 
new scenario will be based upon. 

2.		 Select New scenario and enter a title and notes. The input parameters 
from the original scenario will be copied into the Input parameters tab 
for the new scenario. The Output tables will be removed. 

3.		 Edit one or several input parameters – you can change them 
individually, in groups with the Fill selected range feature or by copying 
and pasting blocks from Excel. Save your changes. 

4.		 Run the new scenario with a representative number of cases (usually 32 
million cases or more). 

tUtoRial: cReate a new scenaRio to Reflect 

pRoVincial data 

In this tutorial, you’ll learn how to create a new scenario from the base 
case scenario. The new scenario will reflect a customized status-quo 
scenario for your province. For the purposes of this example tutorial, 
imagine that new data has just been published on observed colorectal 
cancer incidence rates in Newfoundland. The tutorial will walk through 
the process of creating a new scenario with the revised incidence data 
in the incidence rates input parameter. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

find the Cancer Risk Management Model 1.2 folder, and the Public 
Scenarios folder. 

single-click to open base case scenario (default) 

click the input parameters tab. 

click new scenario (just above the parameter list) or select New scenario 
from the File menu. 

type in the title for the new scenario 
· Tutorial Provincial Status Quo from Base Case 

type or copy/paste in the following notes: 
· Create new status-quo for our province. 
· Updated incidence rates to reflect example tutorial data. Parameter: 
Colon cancer observed incidence rates. 

· All other parameters remain the same as in Base Case. 

click save. 

After you click Save, notice that the title of the new scenario is now at the top of the 
page, and the status has changed to ‘Ready to run’. 

Note: The output tables tab has been removed, since no output projections have yet 

been generated for this new scenario. After the new scenario is run, the Output Tables 

tab will be displayed with the new projections. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

You should always look at the parameter information for the parameter you expect 
to change. It will provide details about how the value of the parameter is computed 
and measured. 

expand the parameter groups for Colorectal cancer, then Incidence, then 
Colon cancer clinical incidence. 

select the parameter: Colon Cancer observed incidence rates. 

Click the Information button  beside the parameter title. 

The information note for this parameter shows that the data is derived from 2004 - 
2006 Canadian data, so we can be confident that our new published rates are more 
relevant to our province for this research project. 

click back or use Return to previous view to return to the value view. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

In order to change the Incidence rates, we will copy the existing rates from the 
parameters into Excel, make the required changes, and then copy them back. 

select the parameter Colon cancer incidence rates (clinical detection). 

Notice that we are only seeing one gender at a time because they have 
different rates. For the purposes of tutorial brevity, imagine that our new 
data is only for males. 

select male from the Sex filter above the table. 

Experiment with selecting an entire dimension or entire row so that in 
the future, you can copy and paste an entire selection from Excel or fill a 
selected range with a single value. 

Click on the age dimension name tile in the top left corner of the grid. Every 
cell will be selected. 

Click on newfoundland and labrador (the row title) to select the entire 
row of data. 

select copy from the edit menu. 

Note: Always use the Edit menu in CRMM for copy and paste rather than 
right-click or keyboard shortcuts – see Copy and Paste from Excel. 

Don’t worry about the exponential format, Excel will handle it. 

open a new excel workbook, and paste the data onto the blank sheet. 

Note: As in the example on the next page, you might also wish to fill the 
first row with a series up to 99, because the clipboard contains only the 
values, not the row or column headings (in this case, the Age headings 
for the columns). 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

You should know that an alternative to copying the input parameter data also exists. 
You could export the entire parameter into an Excel workbook (using the Export 
button or selecting Export data from the File menu). This would ensure that all row 
and column headings are available in the exported workbook. For the purposes of 
this tutorial, we’ll stick to the simply copy and paste here. 

For the purposes of this tutorial, we will just change a few values before stepping 
through the process of pasting the data back into the parameter. In reality, you 
would likely paste your own incidence data into the correct age cells. The intent of 

this section is purely to illustrate how input parameters can be pasted from Excel. 

For example purposes, change the values under ages 61 to 65 to 0.0019. 

Now copy the entire excel workbook row (imagine that you’ve made changes). 

Return to your browser window — where the Newfoundland and Labrador 
row is still selected. select paste from the edit menu. 

Pull the horizontal scroll bar over so that you can see the changes — they’ll 
be highlighted in yellow. click save (beside the Status message) or select 
save scenario changes from the file menu. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

Collect your thoughts: So far, you have... 

· Created a new scenario from the Base case scenario which 
cleared the existing output projections. 

· Changed input parameters to reflect your provincial status 
quo, by pasting from Excel (you can also double-click in an 
individual cell to edit one cell at a time). 

· Saved the changes. 

To learn more about editing parameters, including how to customize 
your browser to reduce the number of warning messages you might 
see, see the later section: Details: Editing Parameters. For this tutorial, 
there’s one more parameter editing feature to learn before we run 
this scenario. 

pull the horizontal scroll over so that you can see the column for age 85. 


Notice that ages 85 all the way to 100 hold the same value of: 

0.0048316252
	

double-click to edit the cell for age 85 to set it to the new value of 

0.0059114455 


Yes, you could have done this in Excel, but we wanted you to try this 
useful feature! 
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 GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

Now click and drag to select the rest of the row, starting from 85, up to 99. 

From the edit menu, select fill selected range. It will fill the selected block 
with the value in the top left corner (or in this case, the value in the left cell 
of the selected row). All of the new values will be highlighted in yellow. 

click save. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

click the Run link above the parameter list or select Run scenario from 
the file menu. 

For the purposes of this tutorial, leave the simulation size at the 
default of Test. 

Note: The Base Case was run with 32 million cases, however, for the 
purposes of the tutorial, we will submit a faster smaller run with only 
moderate reliability — see Reliability. 

click submit. 

The All Scenarios page will be displayed. The new scenario is in the 
Working Sets folder. 

You may be able to watch your new scenario progress through the run stages. 
Depending on how many scenarios are running on the CRMM servers at any one 
time, and their run sizes, a run may take just a few minutes or several hours. For this 
reason, a progress indicator is not displayed. 

Since you are sitting here though, click the 
browser’s Refresh button . 

You should see that the progress has changed. Later, when the run is completed, 
the scenario will appear in the My Scenarios folder on the All Scenarios page. 

This is the end of the directed tutorial. The Next Steps section below is provided 
so that you read through and understand the possibilities of how you might use 
this new scenario. 

A note on parameter changes: For illustration purposes, this tutorial only changed 

a few values in the observed incidence rates parameter. Users are encouraged to 

examine all other related parameters to ensure proper value input for new scenarios. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

next steps 

At this point, you might wish to compare the output table of interest with the one 
from the base Case scenario to examine the general trend in the costs in one versus 
the other. Sure enough, as expected, since observed incidence rates were increased 
slightly for a few age groups, the incidence rates in the output projections show 
a trend towards higher values in the Tutorial scenario versus the original base case. 

For the purposes of the tutorial, we ran this as a test simulation with 2 million cases. 
If you were to Compare Entire Scenarios with the base Case scenario, most values 
would be different because of the different run sizes. To create a reliable status-quo 
scenario for your province, you must run it with an equivalent number of cases. 

To create a comparable status-quo, you would follow the ‘create new scenario’ process 
to create a new scenario as a copy of the test scenario (with a slightly different name). 
Since the parameters were copied from the tutorial scenario, you could skip straight 
to running without changing any parameters. A run of 32 million cases would be 
required to be comparable to the existing base case scenario– see Selecting Run Sizes. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

cReating a high Reliability scenaRio fRom a modeRate test 

RUn scenaRio: an example 

step 1: Click New scenario when viewing the existing test-run scenario. 

step 2: Give the new scenario a slightly different name (here we added “Full”). 
Don’t forget to add your information notes about the scenario! 

step 3: Run this scenario with Medium simulation size selected for high reliability. 

Once the run completes, your new status-quo scenario would be ready to be used 
as a reference in your research. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

tUtoRial: cReate a scenaRio foR a new dRUg with 

a CanCeR ManaGeMent WoRkbook 

In this example, purely for the purposes of a simple tutorial, we’ll 
examine the impact of a hypothetical chemotherapy drug we’ll call 
‘CAZ’. Imagine that CAZ is a new variant of CAV (cyclo-adriamycin-
vincristine) that dramatically reduces neuropathy side effects. In Model 
1.2, CAV is used as 2nd line chemotherapy for Small Cell lung cancer. 
In this tutorial ‘What-if’ scenario, new drug CAZ will be provided to 
50% of the Small Cell patients — the rest will continue to receive the 
existing CAV formulation. Assume that the new drug CAZ will cost 
slightly more than CAV. We will start from the base case scenario. 

find and expand the Cancer Risk Management Model 1.2 folder & 
Public Scenarios. 

single-click to open the base case scenario (default). 

click the input parameters tab. 

click new scenario (just above the parameter list) or select New scenario 
from the File menu. 

type in the title for the new scenario as shown below. 

Tutorial - New drug CAZ for Small Cell Extensive 

cut and paste the notes from below — they are shown here to emphasize 
the importance of note-creation to document a new scenario. 

This scenario examines the impact of upgrading 2nd line treatment for 
Small Cell Extensive lung cancer for half of the patients to new drug CAZ. 

Parameter changed: Lung cancer treatment costs for Chemotherapy 
2nd line –drug. 

click save. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

After you click Save, notice that the title of the new scenario is now at the top 
of the page, and the status has changed to ‘Ready to run’. The output tables tab 
has been removed, since no output projections have yet been generated for this 
new scenario. 

The change that will be required for this new drug is the proportion of patients 
treated, and the costs. This is where the workbooks come in. The proportion of 
patients treated is a variable in the workbooks used to compute the aggregate cost 
per stage of the treatment. This aggregate cost was then entered in the Lung cancer 
treatment costs input parameter. Go take a look at this parameter now. 

expand the Lung cancer and Treatment groups. 

click the lung cancer treatment costs parameter. 

Never change a parameter without viewing the information first, to see 
how it is computed or measured or formatted. 

click the information button beside the parameter title. 

Notice in the information that it says these costs were ‘aggregated… 
from the Lung Cancer Management Data Excel workbook’. 

before we look at the workbook, check the current cost value for 2nd line 
chemotherapy for Small Cell Extensive lung cancer. 
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 GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

Click the back button or use the Return to previous view link. 


select small cell extensive from the Stage filter menu above the parameter values.
	

find the value for Chemotherapy 2nd line. 

make a note of this value: $1076. 

This is the parameter that will change for the new scenario. The costs for Drug CAZ 
were generated from the Lung Cancer Management Data CRMM1209 workbook. 
For ease of computing, you may download this workbook to the desktop in order to 
further analyze and modify. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

If you haven’t already downloaded the workbook: 
click the all scenarios link. 

find the Model Documentation folder, and click on Lung Cancer 
Management Data CRMM1049.xls 

You should see a download dialog, asking you to either open or save. 
save the file on your desktop. 

The first worksheet you see will be the Instructions. It describes how to use the 
workbook and how to map the values back into the particular input parameters. 
Find the instructions for the treatment costs. 

Notice that the instructions detail that the aggregated costs in the pink cells are 
meant to be copied into the input parameters. For the purposes of this tutorial, 
we’ll assume that the price is $80 per cycle and that administration of the drug will 
be identical to CAV. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

before you make changes, use save as to give the excel file a new name, so 
as not to mix up this tutorial example with the real workbook. 


click the costs-chemo worksheet tab (the sheet tabs are located along the 

bottom of the window). 


Notice cell A17 — currently ‘New drug - specify name’. click on it once — the 

link will bounce you down to cell A123. That’s where we’ll create this drug’s profile
	

enter the name ‘tutorial drug caz’ for the drug name in cell A123.
	

enter $80 into the Unit cost per cycle in cell b123. 


enter all of the values into rows 123-132 for New Drug AZ. 


This new drug reduces the neuropathy side effects versus CAV so we’ll reduce 
the nursing time to 30 minutes per cycle. 

Notice that the total cost (in pink on the top row -cell N5) has not changed yet, 
because in the current sheet, none of the patients are yet receiving the new drug. 
Setting up the proportion of patients who will receive the new drug is the final step 
in this process. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

In cell n17, on the new drug line, enter 50 to represent the 50% proportion 
for this treatment. 

Reduce the Cav percentage from 100% to 50%. 

Notice the total cost in cell N5 for SC Extensive 2nd line has increased 

from $1076 to $1096.
	

Your computation of the treatment is complete. You’ll copy the value of 

cell N5 to the parameter in the model.
	

save your Excel workbook for 
future reference. 

Return to the CRMM view of the lung Cancer treatment costs parameter in 
your browser window. 

click on the drug cell for Chemotherapy 2nd line – it will turn grey to show it 
is selected. 

enter the new drug cost of $1,096 in the cell. 

click the save link (above the Parameter list) or select Save scenario changes 
from the File menu. 
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

At this point, the scenario is ready to run. For tutorial purposes, 
we’ll just run a test. 

click the Run link above the parameter list or select Run scenario from the 
File menu. The simulation size is set by default to Test. 

click submit. 

The All Scenarios page will be displayed. Notice that the new scenario is in 

the Working Sets folder. It will remain there until it has completed running. 


select the new drug caz scenario. 


click the details link to see the details of the status.
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GENERATING NEW PROJECTIONS bY CREATING SCENARIOS 

Once the run is completed, the Output tables will be displayed. 

This is the end of the directed tutorial. Refer again to the Next Steps section of the 
previous tutorial for reminders on how to proceed through running the scenario 
with a run size comparable to the base case. 
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details: 

editing inpUt paRameteRs 

change the RepoRt yeaR in single yeaR 
oUtpUt tables 
While most output tables report results by year for 20 years, some output tables 
present the results for a single year. On the list of output tables, these include the 
words ‘In a single year as selected by the user’ in the title, e.g. Life expectancy of 
persons born in a single year as selected by user. 

If you need to use a different year for those tables, you can re-run an existing 
scenario with a different default year or you can change the default year for any 
new scenarios you create. The parameter to reset the default year is in the Special 
tabulation parameters group at the bottom of the parameter list. 

example: To create a new scenario for the base Case with the default year of 2012: 
· click new scenario, provide a title and notes that specify the year change, 
and then Save. 

· click to select the year  to report in single year tables. 
· edit the year  to the year you prefer to see in all single year output tables 
and save. 

· Run the scenario  with 32 million cases so that it is comparable to the existing 
base Case scenario. 
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EDITING INPUT PARAMETERS 

tURn off the inteRnet exploReR waRning foR 
editing paRameteR cells 
If you are using Internet Explorer version 8, you may get tired of seeing this warning 
every time you edit a parameter cell. To turn it off in Explorer 8, see this site: 
http://msdn.microsoft.com/en-us/library/bb250473(v=vs.85).aspx 

setting a paRameteR Range to a single ValUe 
There are many parameters in which a range of the cells are set to the same value. 
Rather than change each value individually, the fill selected Range feature will fill a 
row or block of cells with the value in the top left corner of the selection. 

To fill a range, follow this sequence (similar to the Fill command in Microsoft Excel): 
· edit the source cell for the fill (in the top left corner) first to. 
· select the range that you wish to fill with the source value. 
· select ‘ fill selected range’ from the Edit menu. 
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EDITING INPUT PARAMETERS 

impoRting paRameteR ValUes fRom 
otheR scenaRios 
To answer a particular research question, you may wish to combine input 
parameters from a number of scenarios. After starting your new scenario from 
an existing scenario, you can then import values from the same parameter in 
a different scenario of the same model, or you can import values from an output 
table of a different model. 

For example, perhaps you have created a complex new scenario with multiple parameter 
changes, and you wish to better understand a particular effect in the projection 
by isolating the parameter changes. To do so, you can create your new scenario from 
the Base case (effectively resetting all parameters to the Base case set of default 
parameters) and then import values from the same parameter in your original 
complex scenario in the same model. 

how to import parameter values: 
· create a new scenario from an existing scenario. 
· select the target parameter. 
· select import values  - specify the model and scenario that hold the matching 
parameter, submit. 
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EDITING INPUT PARAMETERS 

copy and paste into paRameteRs fRom 
micRosoft excel 
For some parameters, it is useful to copy and paste ranges of cells to and from Excel, 
often because you wish to perform some computation on all of them and then 
return them to the parameter. Other parameters are set up in the workbooks in a 
tabular format identical to the parameter to enable easy cut and paste from workbook 
to parameter. The New Drug Tutorial has an illustrated example of pasting a cell value 
from an Excel Cancer Management Workbook into a single input parameter cell. 
The Provincial Status Quo tutorial has an illustrated example of the complete process 
of copying from a parameter into Excel, editing, then pasting back into the parameter. 

important: 
·	 To select the entire row or column, click a row or column title and drag to 

select some or all rows or columns.
	

·	 Use copy and paste from the Edit menu as shown below, when copying from 
or pasting into a parameter range or output table range in CRMM. The copy 
and paste commands may not function correctly if you attempt to use right-
click or to use the keyboard short-cuts of control-c and control-v. 

· click paste then wait  — there is a slight system delay while the range of cells is 
validated. It might seem as if your click didn’t work, but it probably did – wait 
those few seconds instead of clicking again. 

· Use the recommended browser  — copy and paste from the Edit menu may 
not perform as specified on any browsers other than Internet Explorer version 
8 or version 9. 
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EDITING INPUT PARAMETERS 

expoRtInG values Into an exCel WoRkbook 
Rather than copy an entire parameter into Excel, use the Export Data button or select 
‘Export data’ from the File menu. The advantage of Exporting is that the column and 
row headings will export with the values. The copy command from the Edit menu is 
best suited to smaller selections of data since only the values are copied. 

If you are using Internet Explorer 8, you may need to click ‘Download File’ in the 
warning bar at the top after the Export command, and then click the Export button 
and Ok again. See the Exporting Data Example in the first tutorial. 
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details: 

Run sIzes & RelIabIlIty 

selecting RUn/simUlation sizes 
The run size specifies the number of cases that will be generated when the scenario 
is run. Each case represents an individual synthetic life that will be lived according to 
the model algorithms. The greater the number of cases simulated, the smaller the 
Monte Carlo error, with an associated reduction in the variability for each outcome 
projection measure. Thus, running more cases will produce more reliable results, 
up to a certain point in which the coefficient of variation (standard error) is within 
a range acceptable to the user. 

All Public Scenarios were run with 32 million cases (the SE on life expectancy was 
less than 0.04 years). 

why Use the test Run? 

The Test simulation size is suggested as a first step for building new scenarios. 
Running a test will allow you a chance to check that the trends appear to be in the 
right direction, and perhaps run a Compare Entire Scenarios to inspect that you’ve 
changed all of the parameters to the settings you had planned. 

Note that while the reliability may be moderate when looking at a particular full 
measure, it tends to rise to unacceptable levels when broken down into measures 
like provinces or age groups in some output tables. 

Once you’ve checked that everything seems to be in place, create a new scenario 
by copying the test scenario, and then skip directly to the Run command to run at 
medium or a higher custom value. 
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RUN SIZES & RELIAbILITY 

RepResenting the popUlation of canada 

All scenarios, regardless of the number of cases requested, are scaled to the size of 
the Canadian population. This ensures that outcomes are always representative of 
the Canadian population. The reliability of the projections will vary according to the 
number of cases requested. 

Reliability 
To assess the reliability of the values in an output table, use the Output menu to 
display either the Coefficient of Variation (CV) or the Standard Error (SE). 

These output measures represent the variation in results due to Monte Carlo error. 

Monte Carlo error is generated by the stochastic processes (in this case, use of 
random numbers) in the Cancer Risk Management Model. Monte Carlo error can 
be reduced (to an arbitrarily small amount) by increasing run size to a sufficiently 
large size at the expense of time it will take to run the cases. 

In practice, you should examine the CV and SE for particular output values to 
understand if, for instance, year to year fluctuations are likely explained by Monte 
Carlo error, or it there is something deeper happening within the data and algorithms. 

The measures of variation in CRMM do not represent the variation in the input 
parameters, often called ‘parameter uncertainty’. This variability is not captured or 
quantified. Users may wish to perform sensitivity analyses to evaluate the impact 
of uncertainty of key input parameters on outcomes. 

In general, results from simulation runs intended for use in policy development should 
have coefficients of variation of 5% or less (from Statistics Canada: Guide to the Modgen 
Visual Interface v10.1.0). The Coefficient of Variation in CRMM is displayed as a 
percentage, as shown in the image at left below. CRMM does not display dollar signs 
or percent signs in the cells – instead, look above the table to the ‘Current Output 
Display’ for the format. Standard errors are shown in the same format as the 
projection values. 
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RUN SIZES & RELIAbILITY 

Notice that in some output tables, you can filter the cases down to a small group of 
the original cases run. For these projections, coefficients will likely be far above the 
target range of 5% or below. In the example below, the view of the original cases has 
been reduced to the Females from the Northwest Territories and Nunavut. Notice 
that the coefficients for this small group have risen beyond 50% rather than 5%. 
Despite the run size of 32 million, these values suggest that the projections for this 
small group should not be considered reliable. To work with projections for sub-
groups in your research, larger run sizes should be considered. 

stanDaRD eRRoR values – speCIal Cases 

In some tables, it is possible that the standard error has a value set to <blank> which 
indicates that the standard error cannot be estimated due to a low number of sample 
cases for the cell. Increasing simulation run sizes will reduce the standard error. 

CoeffICIent of vaRIatIon values (%) – speCIal Cases 

In some tables, it is possible that the CV has a value set to <blank> which indicates 
that the CV cannot be estimated. The corresponding estimate is thus extremely 
unreliable and should not be used. 

It is also possible that the CVs will contain extremely large values. This is often the 
case for cell values that fluctuate between positive/negative values but average 
close to zero. In this case, the use of CVs to indicate reliability is inappropriate. 
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details: 

CHanGInG tables & paRaMeteRs 
display to sUit yoUR needs 

There are a number of ways in which you may need to change or 
format output tables or parameters. Video tutorials to help you learn 
how to use the formatting options for both views are available under 
the help menu. The tutorials relevant to changing views are: 

· Selecting items to display 

· Changing number formats 

· highlighting exceptions 

· Saving table and parameter 
views 

When viewing a table or chart, the Display Options button and Chart Options button 
(shown below) display the formatting available for the data or chart view. Save the 
view (see the tutorial above on Saving table and parameter views) if you would like 
to make this your default view for the future. 
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UndeRstanding data soURces 
and RefeRences 

WHat DoCuMentatIon Is avaIlable? 

Latest evidence from cancer research and current clinical practices 
in Canada were the default input values of the Model. Companion 
documentation such as Information Note, Data Dictionary, and cancer 
type-specific workbooks are put in place to assist interpretation of the 
input parameters. 

INPUT 
PARAMETER 

Excel 
Workbook 

Data 
Dictionary 

Information 
Note 

TYPES OF MODEL DOCUMENTATION 

input parameter: the value assigned to a particular input to the scenario. 

example: Values for the input parameter Lung cancer observed incidence rates 
are assigned by province and age group. You may wish to change the input 
parameter values for a particular age group if you have updated data that 
differs from the rates used in the input parameter. 
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UNDERSTANDING DATA SOURCES AND REFERENCES 

Input parameter information: the information provides the background for the value(s) 
of the input parameter. All information notes are structured in a similar format. 

example: The information for the Lung cancer observed incidence rates starts 
out like this: 

Description: Observed rates are derived from three years of data 2004-
2006. Observed rates are required … 

dimensions: Province, sex, and age group (5-year) 

source: 1.Canadian Cancer Registry (Statistics Canada) Master File of June 
05, 2009 based on the International Agency for Research on Cancer (IARC) 
rules for identifying cancer cases… 

Data Dictionary of all input parameter information: This PDF document contains all 
of the parameter information pages pulled together into a single document. 

excel Workbooks: the Microsoft Excel workbooks are essential to understanding the 
design of the model. The workbooks capture design assumptions, references where 
available and computations of input parameters, particularly costs for drugs and services. 

technical Model Documentation (encyclopedic): This document is provided for 
expert modelers who wish to understand the metadata for the model — all of the 
elements of the model and their relationships. 
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UNDERSTANDING DATA SOURCES AND REFERENCES 

which docUmentation will answeR yoUR 
QuestIons about tHe MoDel? 

Look at the questions below to decide which source you’ll need. 

you Want to knoW WHy a sCenaRIo oR output table 

was cReated 

find it in: Scenario or Output Table Information — describes the purpose of the 
scenario or output table. 

example: The scenario information for the scenario titled Never smoking in 
Canada explains the purpose of the scenario and the input parameter which 
was changed to produce the scenario: “This scenario is used to evaluate the 
net impact of smoking on lung cancer, by asking what if there was never any 
smoking in Canada (past, present or future).” This is achieved by changing 
parameter called ‘Smoking cessation options’. 

format: built-in information note. This information was entered when the 
scenario or output table was created, or the input parameter was created 
or changed. 

how to: Click the button beside the scenario/output table title. 

tip: When you create new output tables or scenarios, use these notes in a similar 

fashion to document your changes. The note entry area is shown with the title 

immediately after you click New scenario. There is also an option to change the title 

or note any time before the scenario is run (select Change scenario title and note 

from the File menu). 
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UNDERSTANDING DATA SOURCES AND REFERENCES 

yoU want to see the ValUe Used foR a paRticUlaR inpUt 

paRameteR in a scenaRio. 

example: Radon levels differ across the country. The Radon Exposure input 
parameter in the base case scenario shows that the value of the geometric 
mean radon exposure in Vancouver is set to 5.2. 

input parameter: Selecting an input parameter displays the values in rows 
and columns. 

format: built-in view of Input Parameters in a scenario 

how to: Open a scenario, click on the Input Parameter tab, and then click 
the parameter you want to view. 

you Want to knoW WHy a paRaMeteR Is set to a paRtICulaR 

ValUe in the base case scenaRio oR why/how it diffeRs 

fRom the base case foR any otheR scenaRio. 

example: In the example above, we see that radon exposure in Vancouver 
is set to 5.2. The parameter information explains that these values are 
expressed in terms of “Bq/m3, which is a unit usually used for measuring radon 
concentration.” The parameter information also reveals assumptions about the 
Radon data and describes how it is used in the model, e.g. “As we only have 
data from 17 cities from 9 provinces, we assign each simulated individual to 
one of two places within the province, either a city for which we have radon 
data or elsewhere.” 

parameter Information: the information page provides all of the 
background for the value(s) of the input parameter. All information notes 
are structured in a similar format. 

format: built-in Information view. 

how to: Click the  button beside the parameter title. 
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UNDERSTANDING DATA SOURCES AND REFERENCES 

RatHeR tHan look at paRaMeteR InfoRMatIon notes 

one by one, you Want to look aCRoss an entIRe set of 

InfoRMatIon notes anD folloW tHe lInkeD ConneCtIons 

oR yoU want to Read the paRameteR infoRmation aboUt a 

paRaMeteR WHIle you look at tHe paRaMeteR values. 

Data Dictionary: All of the Parameter Information pages for a model’s base case 
scenario are collected into a single searchable document. 

format: PDF document. 


how to: Use All Scenarios to return to the main view, open the model’s 

Workbooks folder, and click the dictionary. 


tip: To reduce browser load, save the document to your computer via your 
browser. You can then open and use the document through Adobe Reader. 

yoU want to see all of the costs, compUtations and 

assUmptions Used to cReate the ValUe foR a paRameteR, 

and potentially change a ValUe in the compUtation in 

oRdeR to change a paRameteR to RUn a scenaRio. 

OR, 

yoU want to UndeRstand the flow of a paRticUlaR canceR 

thRoUgh the pRobabilities foR each step and stage. 

example: While you can see that the probability associated with use of 1st, 
2nd and 3rd line chemotherapy for Stage IV incurable colon cancer in the Colon 
cancer treatment probabilities parameter in the screen-image at left below, you 
may better understand these values by viewing it in the flow diagram shown 
in the workbook. 
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UNDERSTANDING DATA SOURCES AND REFERENCES 

For an example of how you would use the Excel Workbooks to adjust a cost 
parameter, see the tutorial Create a Scenario for a New Drug with a Cancer 
Management Workbook. 
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UNDERSTANDING DATA SOURCES AND REFERENCES 

workbooks: The Microsoft Excel workbooks are essential to understanding the 
design of the model. The workbooks capture design assumptions, references where 
available and computations of input parameters, particularly costs. Choose the 
workbooks associated with the model you are currently working with. The values 
in the workbooks for a version of the model will match those in the CRMM base 
case parameters for that model. 

how to: Find and click the XLS workbook for the cancer or model of interest. 
The model will download when you click (watch out for browser download 
warnings and ok them if they appear). Find the workbook and open it with 
Microsoft Excel. 

tip: If you modify a Workbook, use SAVE AS before you modify so that if 
required, you can track and change back to the original settings in the workbook. 
The workbooks are self-documented – the first sheet provides instructions on 
how to use the sheets to match to the parameters, and there are notes and 
references throughout the workbooks to ease your exploration and usage. 

yoU want to UndeRstand the defining chaRacteRistics of 

a paRtICulaR MoDel (paRtICulaRly Relevant If you Have 

been usInG a pRevIous veRsIon). 

Model Information: Explains what is different/updated in this particular version 
of the model. 

how to: Click the  button beside the model title on the All Scenarios page. 

yoU want to UndeRstand the dependencies in the model, 

mainly between the inpUt paRameteRs and the associated 

oUtpUt tables. 

technical Model Documentation: Describes the metadata for the model — all of 
the elements of the model and their relationships. 

how to: Click the book button beside the model name 
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